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computationalمحاسباتیهایروشامروزه methodsروشاینازاستفاده.داروهستندطراحیهایپروسهدرنشدنیجداجزیک

ایه،پعلومبامرتبطمختلفهایشاخهدرگستردهطوربههمچنینهاتکنیکاین.گرددمیداروطراحیزمانوهزینهکاهشباعثها

درچههاکنیکتتریناستفادهپرازیکیمحاسباتی،متعددهایروشمیاناز.گیردمیقراراستفادهموردمحققانتوسطپزشکیوزیستی

.استمولکولیداکینگتکنیکداروسازی،بامرتبطصنایعدرچهومختلفعلوم

هایوریتمالگازاستفادهباگیرندهیکفعالیجایگاهدروندرلیگاندیکاتصالنحوهبینیپیشازاستعبارتمولکولیداکینگ

هایاسیدواهپروتئینمانندهاییماکرومولکولباکوچکمولکولهایبینهایهمکنشبرنحوهبررسیبرایتکنیک،این.کامپیوتری

افزارهاینرمآنهاازیکهربرایکهشودمیگرفتهکاربهمختلفهایماکرومولکولبینهمکنشبریاوگیرندهعنوانبهنوکلئیک

.داردوجودمختلفی

داکینگ مولکولی

Link: https://telegram.me/VIBCBC_ir
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برایدهییازامتسپسگیرندهرویاتصالجایگاهدرلیگاندبرهمکنشنحوهوگیرندهجهتنحوهبررسیمراحلشاملداکینگفرایند

افزارهاینرمدرعواقدر.باشندمیاتصالجایگاهدر(هاکانفورماسیون)لیگاندگیریقرارنحوهبینیپیشهایحالتتمامیبندیرتبه

استفادهالاتصجایگاهدرلیگاندگیریقرارنحوهممکنهایحالتانواعجستجویبرایکامپیوتریهایالگوریتمازیکیازداکینگ

میگاندلیگیریقرارممکنحالاتانواعبررسیبرایجستجوهایروش.باشدمتفاوتتواندمیافزارنرمنوعحسببرکهشودمی

.باشند(کارلومونتوژنتیکهایالگوریتممانند)تصادفیروشهاییاوسیستمیکهایروشتوانند

اتصالانرژیبحسبرتواندمیوبودهمتفاوتافزارنرمنوعحسببرنیزبندیرتبهوشدهایجادهایکانفورماسیونبندیامتیازنحوه

.شودبیاندیگرعددیمبناهاییا

اینغیررد.گرددمیانجامترآسانداکینگکارباشدشدهشناختهآنفعالجایگاهوگیرندهساختاردرچنانچهداکینگانجامبرای

وگشتهنیبیپیشآنفعالجایگاهوگیرندهساختارباشندمیدسترسدرکهمولکولیبندیمدلمختلفروشهایبابایدصورت

.بگیردانجامداکینگسپس

Link: https://telegram.me/VIBCBC_ir
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رویاتصالجایگاهو(Flexilbe)پذیرانعطافصورتبهداکینگپروسهدرطوللیگاندمعمولاًداکینگافزارهاینرمدربیشتر

اتصالجایگاهپذیرانعطافامکانافزارهانرمازبرخیدرهرچند.شودمیگرفتهنظردر(Rigid)انعطافقابلغیرصورتبهگیرنده

گیرندهرویاتصالجایگاههمولیگاندهمنیزافزارهانرمبرخیدر.دهدمیافزایشرامحاسبهزماناینکهداردوجودنیزگیرندهروی

.شوندمیگرفتهنظردرانعطافقابلغیرصورتبهدوهر

ازآبمولکولهایگیرنده،حذفولیگاندساختارسازیآمادهشاملکلیطوربهمراحلداکینگافزارهاینرمدرکلیطوربه

تعیینرنده،گیرویاتصالجایگاهکردنمشخصها،اتموپیوندنوعگیرنده،تصحیحساختاربههیدروژننمودناضافهساختارگیرنده،

.شدبامیدیگرگرافیکیافزارهاینرمیاافزارنرمخودباحاصلهایدادهآنالیزنهایتدروداکینگانجامداکینگ،پارمترهای

برایمتعددیافزارهاینرمامروزه.ندارندشباهتهمانبالزوماًمراحلونیزنداشتهوجودمراحلهمهلزوماًمختلفافزارهاینرمدر

بهیارایگانصورتبهتوانندمیافزارهانرم.دارندراخودبهمختصهایکاراییوکاربردکدامهرکههستنددسترسدرداکینگ

.استدسترسیزیرقابللینکدرافزارهانرمازکلیلیست.باشنددسترسدرهزینهپرداختوتجاریصورت

https://en.m.wikipedia.org/wiki/List_of_protein-ligand_docking_software
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این.استAutodockاتوداکبرنامهمولکولیداکینگانجامبرایافزارهانرمترینپراستنادوترینهپراستفادترین،کاربردیازیکی

.داردقراردراختیارهمههمگانیاستفادهبرایرایگانصورتبهافزارنرم

Autodockافزارهاینرماستافزارلازمنرماینباداکینگانجامبرای tools (ADT)وAutogridبرنامههمراهبهنیز

.کردفادهاستتوانمینتایجمشاهدهنیزوداکینگانجامبرایلازمپارمترهایوهافایلسازیآمادهبرایآنازکهشودنصباتوداک

.باشندمیدانلودقابلزیرآدرسازافزارهانرم

http://autodock.scripps.edu/downloads

میوکسلینعاملسیستمدرشدهنصبافزارنرمبامرحلهبهمرحلهصورتبهمولکولیداکینگانجامآموزشی،فایلاینازهدف

.استشدهدادهقرارکانالدرلینوکسعاملسیستمبرایافزارهانرماینشدهدانلودفایلسهولت،برای.باشد

Link: https://telegram.me/VIBCBC_ir

http://autodock.scripps.edu/downloads
https://telegram.me/VIBCBC_ir
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هرچهواردازه تکاربراناستبهتربنابرایناستضروریولازمامریکبیوانفورماتیکدر(لینوکس)اوبونتوداشتن

کنندنصبنیزروعاملسیستماینخودبوکنوترویبرزودتر

:شکلدوبهمارواوبونتونصب

Dualصورتبهوویندوزکناردر-1 Boot

Virtualمجازیشکلبه-2 boxمیکنیمتوصیه

.شودوردهآشمابرایسرچنتیجههزارانتااوبونتونصبآموزشبزنیدسرچگوگلدراستکافیاوبونتونصببرای

Link: https://telegram.me/VIBCBC_ir
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.کنیداستفاده17یاو16ورژنازازبهترحاضرحالدر.نکنیداستفادهقدیمیهایورژناوبونتوازمیکنمتوصیه

Link: https://telegram.me/VIBCBC_ir
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ید فایل می باشد که می توانگیرنده ما یک پروتئین ویروسی و لیگاند نیز یک مولکول کوچک ،در این فایل آموزشی

.دانلود کنیداین آدرس    PDBکمپلکس آن را با فرمت 

https://www.rcsb.org/pdb/explore.do?structureId=1HSG

میراارکاین.کنیدذخیرهجداگانهصورتبهوکردهجداکمپلکسازرالیگاندداکینگ،ازقبلاستلازممثالایندر

DeepمانندافزارهایینرمبایاPDBفایلدستیاصلاحقبیلازمختلفیروشهایباتوانید viewبرای.دهیدانجام

هانام)کنیدگذارینامindوhsg1ترتیببهراکارشروعازلبقراشدهجدالیگاندوگیرندهنامکارسهولت

.استهشددادهقرارکانالدرلیگاندوگیرندهآمادهفایلسهولت،برای.(دادتغییرراانهامیتوانوباشندمیقراردادی

Link: https://telegram.me/VIBCBC_ir

مولکولیداکینگآموزشدومقسمت

https://www.rcsb.org/pdb/explore.do?structureId=1HSG
https://telegram.me/VIBCBC_ir


16

Link: https://telegram.me/VIBCBC_ir

https://telegram.me/VIBCBC_ir


17

شماکهاستبالاشکلبهتولزاوتوداکافزارنرماصلیصفحه

کنیدنصبویندوزیاواوبونتوبرایبهراآنمیتوانید

Link: https://telegram.me/VIBCBC_ir
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باز کردن فایل رسپتور و آماده سازی آن
تالوگرافی در ابتدا لازم است مولکولهای آب حاصل از کریستالوگرافی از ساختار حذف شده وهمچنین تمامی هیدروژن به ساختار کریس

.بعد از آن فایل ها را میبندیم.بعد از اعمال تغییرات فایل گیرنده باید ذخیره گردد. شده اضافه شود

File --> Read Molecule <<hsg1.pdb باز کردن فایل رسپتور و آماده سازی آن

Link: https://telegram.me/VIBCBC_ir

https://telegram.me/VIBCBC_ir
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Edit -->Delete Water

Link: https://telegram.me/VIBCBC_ir
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Edit -->Hydrogen-->Add

Link: https://telegram.me/VIBCBC_ir

Edit>>Hydrogens>>Add

https://telegram.me/VIBCBC_ir
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File-->Save-->Write PDB

...این آموزش ادامه دارد

Link: https://telegram.me/VIBCBC_ir
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Ligand-->Input-->open
Change files of type to ….all file:   (*)
ind.pdb

 PDBQTآماده سازی فایل لیگاند و تبدیل آن به فرمت 
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ادامه تصویر صفحه قبل
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ادامه تصویر صفحه قبل
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دروشدهاضافهلیگاندبهGastiegerازنوعبارهاییلیگاند،شدنبازازبعد

هایپیوندوهااتمنوعشناساییازگزارشیکهشودمیبازایپنجرهنهایت

.کنیدکلیکOKرویباشدمیلیگاند
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Rootتعیین

میمشخصرنگسبزدایرهیکباکهشودمیتعیینRootعنوانبهمولکولاتمهایازیکیلیگاندبرایمرحلهایندر

.شود
Ligand-->Torsion Tree-->Detect Root

.لیگاندساختاردرچرخشقابلپیوندهایکردنمشخص

Ligand-->Torsion Tree-->Choose Torsions

ایندرداگینگبرایچرخشقابلپیوندتا32حداکثر.می شودمشخصعدد12تعدادبهسبزرنگبهچرخشقابلپیوندهای

پنجرهرویکلیکباراآنتوانمیداریدچرخشقابلپیوندهایوتعدادنوعدرتغییرقصدچنانچه.استقبولقابلافزارنرم

.کنیدکلیکشدهبازپنجرهدرdismissرویصورتاینغیردردادانجامشدهبازهای

Ligand-->Torsion Tree-->set the number of Torsion

Dismiss
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gridتعیین boxگیرندهرویلیگاندداکینگانجامبراینظرموردناحیهکردنمشخصبرای

gridتعیینبرای boxطبقبروباشیمداشتهگیرندهرویلیگانداتصالاحتمالیمحلبهراجباطلاعاتیقبلازباید

.کنیممشخصداکینگانجامبرایراboxمرکزواندازهآن

gridتعیینبرای boxفرمتبهگیرندهفایلبایدابتداPDBQTفایلاستکافیکاراینبرایگرددتبدیلPDB

ذخیرهPDBQTفرمتباگیرندهفایلتاکنیدکلیکشدهبازگزارشپنجرهدرOKرویسپسکردهبازراگیرنده

.شود

Grid-->macromolecule-->Open

Change files of type to ….all file: (*)

hsg1.pdb

Type file name as: hsg1.pdbqt

Save

https://telegram.me/VIBCBC_ir
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کنیممیبازایمساختهقبلازکهراPDBQTفرمتبالیگاندفایلبعدیمرحلهدر

Grid-->Set Map Types-->Open Ligand

ind.pdbqt

https://telegram.me/VIBCBC_ir
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.کنیممیمشخصرابگیردانجامدرآنگیرندهبالیگاندداکینگاستقرارکهboxمختصاتحالا

.شودمیمشخصمرکزیکنیزجعبهبرایوگرددمیتعیینX,Y,Zجهتسهدرجعبهاندازه

.گرفتنظردربزرگممکنحدتاراboxتوانمینباشددستدراطلاعاتیگیرندهفعالجایگاهمختصاتازچنانچه

.

:کنیدبرای این فایل آموزشی اعداد را طبق مشخصات زیروارد 

Grid-->Grid Box

Number of point in X dimension 60

Number of point in Y dimension 60

Number of point in Z dimension 60

X center 14.203

Y center 24.064

Z center 5.078

Save it by

File-->Close and saving current

https://telegram.me/VIBCBC_ir
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کنیممیذخیرهGPFفرمتبافایلیدرراboxبرایشدهتعیینمشخصاتحالا

Grid-->Output-->Save GPF

Type file name as: grid

Save

https://telegram.me/VIBCBC_ir
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گریداتوبرنامهاجرای

رااتوگریدبرنامهطریقدوازتوانمی.داریمAutogridبرنامهبهنیازشبکهساختایجادبرایمرحلهایندر

.شوداستفادهدومروشازشودمیتوصیه.commandطریقازوgraphicalطریقاز.کرداجرا

شدهبازقبلازکهadtدرRUNمنویاز:اولراه

Run -->Run Autogrid

Program path name :

./…………./ autogrid 4

Parameter fie name: Browse

grid.gpf

log fie name: Browse

grid.glg

Lunch

https://telegram.me/VIBCBC_ir
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دستوروبرویدداردقرارآندرهافایلکهمسیریبهcdدستورباوکردهبازTerminalیکلینوکسدر:دومراه

کنیدتایپرازیر

autogrid4 –p grid.gpf –l grid.glg &

https://telegram.me/VIBCBC_ir
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، وارد مرحله اصلی داکینگ mapشدن فایلهایی با فرمت ساخته چک کردن از اتمام کامل اجرای اتوگرید و پس 
 .می شویم

https://telegram.me/VIBCBC_ir
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شروع مرحله اصلی داکینگ

عنوانبهگیرندهفایلاتوداکدر.کنیممیبازراPDBQT(فرمتبادوهر)لیگاندوگیرندههایفایلابتدادر

.باشدمیانعطافقابلداکینگفراینددرلیگانداماشودمیگرفتهنظردرانعطافقابلساختارغیر

Docking--> macromolecule-->Set Rigid Filename

hsg1.pdbqt

Docking--> Ligand-->Open

ind.pdbqt

کنیدکلیکشدهبازپنجرهدرAcceptرویلیگاندشدنبازازبعد

https://telegram.me/VIBCBC_ir
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فراینددراحتمالیهایکانفورماسیونجستجویبرای(افزارنرمایندرموجودهایالگوریتممیانازتوانمیاینجادر

Geneticمثالایندرماکهکردانتخابراالگوریتمیک)داکینگ Algorithmsتعداد.کنیممیانتخابراRUNرا

حاصلنهایینتایجعنوانبهکههاکانفورماسیونتعدادعدداینواقعدر.دهیدتغییر100به10ازراشدهبازپنجرهدر

.نباشد100ازکمتراستبهترومیکندتعیینراشوندمی

Docking--> Search Parameters-->Genetic Algorithms

Change number of GA runs from 10 to 100

کنیدکلیکشدهبازپنجرهدرAcceptروی

Accept

https://telegram.me/VIBCBC_ir
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روینداریدراپارامترهاتغییرقصدچنانچه.کردمشخصتوانمیراداکینگپارامترهایمرحلهایندر

Acceptبپذیریدراداکینگپارامترهایهایفرضپیشوکردهکلیک.

Docking--> Docking Parameters-->

Accept

https://telegram.me/VIBCBC_ir
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.کنیممیذخیرهdpfفرمتبافایلیدرداکینگبرایراشدهامادهمشخصاتتمامیاکنون

Docking--> Output->LamarckianGA(4.2)

Changed the file name to:

dock.dpf

https://telegram.me/VIBCBC_ir
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منوی از  graphicalبرنامه اتوداک را اجرا کرد اول به صورت در این مرحله نیز می توان از دو طریق

RUN  دوم از طریق وcommand  توصیه ما استفاده از راه دوم استکه.

شدهکه از قبل باز adtدر RUNاز منوی : راه اول

RUN-->Autodock-->
Program path name : …./ autoduck4

Parameter fie name:   Browse
dock.dpf
Log fie name:   Browse
dock.dlg
Lunch
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وبرویدداردقرارآندرهافایلکهمسیریبهcdدستورباوکردهبازTerminalیک:دومراه

.کنیدتایپرازیردستور

autoduck4  –p  dock.dpf –l  dock.dlg &

....داردشماسیستمسرعتبهبستگیآناتمامسرعتوشدهشروعداکینگفرایندحال

...این آموزش ادامه دارد
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داکینگنتایجآنالیز
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Autodockازاستفادهباداکینگنتایجآنالیز tools

.کردتفسیررانتایجتوانمیمختلفیطرقبا،داکینگاتمامازپس

Autodock(ADT)ازاستفادهراههااینازیکی toolsاست.

مانندوخصوصیاتینمودهمشاهده(Clustered)شدهبندیدستهصورتبهرانتایجتوانمیADTبرنامهازاستفادهبا

راهاپیونداینطولوگیرندهولیگاندبینشدهایجادهیدروژنیپیوندهایتعدادمانندخصوصیاتسایرواتصالانرژی

.دادقراربررسیموردآمدهبدستکانفورماسیون100ازیکهربرای
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.دهیدانجامرازیرمراحلآنالیزانجاممنظوربه

.ببندیدراباشندبازاستممکنکهمولکولهاییتمامزیردستورطبقبودهبازقبلازاتوداکبرنامهچنانچه

Edit-> Delete-->Delete all Molecules

.نماییدمشاهدهراداکینگنتایجزیرمراحلبامیتوانیدحال

Analyze-> Docking-->Open

dock.dlg

Analyze-> Macromolecule-->Open

hsg1.pdbqt

Analyze-> Clustering-->Show

Click on OK
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ستونیاستونقالبدربندی،خوشهیاclusterصورتبهشدهایجادکانفورماسیون100نتیجهدراینجاحال

.شودمیدادهنمایشهایی

پسشدهایجادکانفورماسیون100ازکانفورماسیونچندینحاویمیتواندوبودهکلاستریکنمایانگرستونهر

.باشدداکینگاز

.کنیدمشاهدهراکلاسترآنخصوصیاتتوانیدمیستونهررویکلیکدبلبا

دادتعبیشترینبردارندگیدرمعرفتربلندستونوداشتهراانرژیمیزانکمترینچپسمتستون

.باشدمیهاکانفورماسیون
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(آیدمیردقرمزرنگبهستونکلیک،دبلازبعد)کنیدکلیکدبلببینیدراآننتایجمیخواهیدکهستونهرروی

کنیدکلیک&شبیهعلامترویشدهبازپنجرهدرسپس

Analyze-> Conformations-->Play

گیرندهودلیگانبینهیدروژنیباندهایانرژی،بهمربوطاطلاعاتتاکنیدکلیکزیرمواردرویشدهبازپنجرهدربعد

.شوددادهنمایش(وجودصورتدر)

Show info

Build H-bounds
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وانتمیآنهارویکلیکباکهداردوجودمربعیودایرهاشکالگیرندهولیگانداسمروبرویپنجرهچپسمتدر
کهindروبرویمثالطوربه.کردمشاهدهرا...وبالنروبان،هایشکلمانندلیگاندوگیرندهنمایشمختلفاشکال

ارلیگاندوگیرندهنمایشنحوهشدنمتفاوتتاکنیدکلیکRدایرهرویگیرندهبرایوBدایرهرویاستلیگاند

.ببینید
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صورتبههیدروژنیپیوندهای.کنیدمشاهدهترنزدیکنمایازراساختارهامیتوانیدموسوسطدکمهدادنحرکتبا

.استشدهدادهنشانخطوطاینکناردرعددیصورتبهنیزآنهافاصلهواستمشاهدهسبزقابلخطوط

.. .این آموزش ادامه دارد 
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داکینگازحاصلنتایجذخیره

.(PQBQTفرمتبا)کردذخیرهزیرطریقازراشدهایجادهایکانفورماسیونازکدامهرتوانمی

راکنفورماسیونایناغلبوداردراانرژیمیزانکمترینشدهتولیدclusterاولینازکانفورماسیوناولین

یجهنتعنوانبهکانفورماسیونتعدادبیشترینباclusterگاهیاماگیرندنظرمیدرداکینگنتیجهعنوانبه

.شودمیگرفتهنظردر

استسازیذخیرهقابلزیرطریقازباشدنظرمدکهموارداینازکدامهرحالهربه

(جداگانهصورتبهشدهداکلیگاندصورتبههمکمپلکسصورتبههم)

Writeروی complexیاWrite currentکنیدکلیک

کنیدتایپدلخواهبهرافایلنام

Save
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PDBبهPQBQTفایلتبدیل

.دهیدانجامرازیرمراحلPDBبهPQBQTفایلتبدیلبرای

File --> Read Molecule

YOUR FILE NAME.pdbqt

File --> Save --> Write PDB

New name.pdb

Save

gedit dock.dlg
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طریق فرمان هایی نظیر ایجاد شده را از dlgکافی است فایل ی،جدولبه صورت نبرای دیدن نتایج هر کانفورماسیو

gedit یاmore کنیدباز لینوکس در.

به پوشه مربوط بروید و فرمان زیر را بنویسید cdباز کرده با دستور  Terminalاین کار یک برای 
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نتایج،فایلانتهاینزدیکدرودادهقراربررسیموردراdlgفایلکلمیتوانSpaceیاEnterکلیدفشاربا

شمارهتر،کلاسهرهایکانفورماسیونتعدادکلاستر،هربهمربوطانرژیکمترینکلاستر،هرمیانگینهایانرژی

.نماییدمشاهدهرا...کلاستروهردرانرژیمیزانکمتریندارایکانفورماسیون
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اولینازکانفورماسیوناولین)نظرموردکانفورماسیونازشدهذخیرهPDBفایلتوانمیبیشترهایآنالیزبرای

clusterازکانفورماسیوناولینیاداردراانرژیمیزانکمترینکهشدهتولیدclusterتعدادبیشترینبا

خصوصیاتنظرازligPlotمثلدیگریافزارهاینرمبارا(دیگرهایکانفورماسیونازکدامهریاکانفورماسیون

.دیدخواهیدراافزارنرماینباکارنحوهادامه،درکهقراردادبررسیموردگیرندهولیگانداینتراکشن

Ligplotافزارازنرماستفادهباداکینگنتایجآنالیز
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Ligplotازاستفادهباهادادهآنالیز

دوصورتهبآننمایشکهباشدمیگیرندهولیگاندبینهایاینتراکشندیدنبرایبرنامهیکپلاتلیگ

سیدهایابینکههیدروفوبوهیدروژنیپیوندهایمانندپیوندهاییبرنامهاینازاستفادهبا.باشدمیبعدی

.استمشاهدهقابلشودمیتشکیللیگاندباگیرندهآمینه

استدسترسیقابلزیرسایتازپلاتلیگنسخهآخرین

(نداردنصببهنیازیوبودهportableصورتبهبرنامه)

https://www.ebi.ac.uk/thornton-srv/software/LigPlus/download.html
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.باشدمیآکادمیکازایمیلاستفادهباسایتدرنامثبتبهنیازپلات،لیگسازیفعالودانلودبرای

Executableبرنامهبایدپلاتلیگبرنامهاجرایبرای jar fileوجستجباکهباشدشدهنصبشماسیستمدرقبلاز

.کنیدنصبودانلودراآنتوانیدمیاینترنتدر

خارجفشردهحالتازراآنwinrarمانندهاییبرنامهباوکردهکلیکشدهدانلودپوشهرویپلاتلیگدانلودازپس

بازرامهبرناپوشه،داخلدرآخرگزینهرویکلیکباشکلمطابقوکردهکلیکشدهایجادپوشهرویسپسسازید

.نمایید
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.کنیدبازراpdbفرمتباگیرندهرویشدهداکلیگاندکمپلکس،Fileقسمتازبعد
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راگیرندهولیگاندبیناینتراکشننتیجهنهایتدروبودهلیگاندشناساییبهقادرپلاتلیگبرنامه

.دهدمینمایشبعدیدوصورتبه
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کردمشاهدهراشدهایجادپیوندهاینوعراهنمایتوانمیزیرشکلدر
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اددتغییردلخواهبهرانوشتهآن،رویکلیکدبلباتوانمیشکلپاییندرشدهنوشتهنامتغییربرای
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Writeرویکلیکبا(فتوشاپافزارنرمبرایمناسب)psفرمتبهراشکلتوانمینهایتدر PS fileذخیره

.کرد
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printگرفتنیاوsaveرویکلیکباپلاتلیگافزارنرمخودبرایمناسبفرمتبافایلذخیرهامکان

ScreenمنویدرگزینهاینرویکلیکباFileداردوجود.
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شمابرایموفقیتآرزویبا
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